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Qu’est-ce qu’une carte conceptuelle? 

Définition : Une carte conceptuelle est une représentation graphique d’un domaine de la 
connaissance tel que perçu par un ou plusieurs individus.  Cette perception – évolutive –  établit 
des liens entre des concepts selon des règles plus ou moins formelles.  

Il s’agit donc d’un schéma permettant de mieux saisir le rapport qui existe entre les différents 
concepts évoqués par l’auteur.  En présentant une vue d’ensemble sous forme de schéma en 
2 dimensions, l’auteur exprime du même coup la connaissance qu’il a des concepts liés au sujet, 
ainsi que la sa capacité à relier ces connaissances pour former des propositions1 plus complexes. 
Selon la méthode ou le type de logiciel employé, les formes graphiques sont structurées dans une 
logique propre – sorte de grammaire de schéma – qui permet d’organiser la communication entre 
l’auteur de la carte conceptuelle et ses lecteurs. 

La propriété d’une carte conceptuelle est 
d’organiser la sémantique des liens pour 
former des propositions.  C’est ce qui la 
distingue des autres méthodes de 
schématisation qui, dans certains cas, se 
limitent plutôt à hiérarchiser des entités. 
 

 
Figure 1 - Carte conceptuelle simple. 

Quels sont les avantages pédagogiques des cartes conceptuelles? 

La réalisation d’une carte conceptuelle oblige son auteur à d’abord activer ses connaissances 
antérieures du sujet2 pour ensuite y « mettre de l’ordre » en proposant une représentation 
hiérarchique (ou semi-hiérarchique) de sa compréhension actuelle du sujet.  Le rappel de ses 
connaissances antérieures crée une situation propice à l’exposition à de nouvelles connaissances, 
et donc de leur intégration à notre savoir actuel. 

Une stratégie d’enseignement 

Dans une logique principalement centrée sur l’enseignement – et donc sur l’enseignant –, la carte 
conceptuelle permet, par exemple, d’effectuer une synthèse compacte d’un propos tenu en salle 
de classe.  Elle permet aussi de « fixer » l’état d’une situation afin de mieux l’observer.  Une carte 
conceptuelle bien construite accepte l’ajout de concepts supplémentaires et favorise donc une 
construction évolutive. 

Une stratégie d’apprentissage 

Dans une logique principalement centrée sur l’apprentissage – et donc sur l’étudiant –, la carte 
permet même de découvrir ce que les étudiants savent à propos d’un sujet en organisant une 
vue intégrative des concepts et des relations qui les unit.  Par exemple, un enseignant peut 
demander aux étudiants d’assembler une carte depuis un certain nombre de concepts proposés 
pour mener une activité de synthèse et de réflexion qui va au-delà de la simple restitution de 
données factuelles.   
Pour l’étudiant, créer une carte conceptuelle pour découvrir (et partager) l’état actuel de ses 
connaissances sur un sujet favorise la discussion et, du point de vue de l’enseignant, permet plus 
facilement de poser un diagnostic sur la compréhension du sujet par son auteur.  En outre, la 
carte conceptuelle tracée par un étudiant permet à l’enseignant d’identifier certaines lacunes par 
l’inventaire des liens manquants ou encore des liens erronées.  Dans ce dernier cas, le travail de 

                                                
1 Une proposition est l’assemblage d’un premier concept relié à un second concept par un lien 
qui comporte au moins une direction (tête de flèche) et qui est explicité par des mots de liaison. 
2 Selon qu’il est novice ou expert du sujet traité, la carte conceptuelle d’un auteur sera plus ou 
moins complexe.  Une carte d’expert possède souvent une forme plus dépouillée car celui-ci sait 
mettre en relation uniquement les éléments essentiels d’une situation, limitant ainsi le « bruit » 
qu’occasionne un niveau de détail trop élevé. 
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l’enseignant débutera par la déconstruction de ces liens inexacts avant même de procéder à 
l’introduction de nouvelle matière. 

Un outil de communication 

Que ce soit dans une logique d’enseignement ou bien dans une logique d’apprentissage ou de 
communication entre les étudiants, la carte conceptuelle permet de partager un point de vue sur 
un sujet en effectuant une synthèse graphique dont l’efficacité est reliée à la compréhension 
mutuelle (auteur-lecteur) du formalisme de représentation employé. 

Formalisme de représentation 

Puisqu’une carte conceptuelle bien construire tend à soutenir la compréhension que l’on possède 
d’un sujet, il importe de se donner des règles de construction qui permettent à tout éventuel 
lecteur de bien comprendre le sens créé par la carte conceptuelle. 
De façon générale, une carte conceptuelle comporte des propositions formées de : 

• un premier concept (un nom); 
• un lien avec une(des) flèches(s) de direction; 
• un mot de liaison (un verbe); 
• un second concept (un nom). 

 
Figure 2 – Exemple simple de propositions. 

 
Dans l’exemple de la figure ci-dessus, nous pouvons tirer deux propositions : 

• Les ondes transportent de l’énergie. 

• Les ondes transportent de l’information. 
Une carte conceptuelle peut contenir les caractéristiques suivantes : 

Tableau 1 - Éléments d'une carte conceptuelle 

Élément Représentation dans la carte 

Propositions 

Formées de 
concepts… 

Forme graphique (exemple : rectangle) qui contient le 
texte du concept3 (habituellement un nom commun). 

…reliés par un 
lien 

Forme graphique (exemple : tracé de ligne) qui se 
termine par une flèche de direction, et exprime la 
relation4 entre deux concepts à l’aide de mots de liaison 
sous forme de texte. 

                                                
3 Il est possible d’appliquer des attributs à un concept (taille, famille et couleur de police, taille, 
forme et couleur de fond de la forme graphique qui contient le concept).  Su vous utilisez des 
attributs particuliers, vous devez exprimer l’effet de sens qui vous souhaitez produire à l’aide 
d’une légende.  Autrement, votre carte sera plus difficilement compréhension pour un lecteur qui 
ne possède pas la clef de votre sélection d’attributs graphiques. 
4 Si vous appliquez des attributs graphiques à vos liens (exemples : type, taille et couleur de 
ligne), alors exprimez l’effet de sens qui vous souhaitez produire à l’aide d’une légende. 
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Élément Représentation dans la carte 

Si la carte conceptuelle est conçue à l’aide d’un logiciel comme CmapTools, alors il est possible 
d’inclure facilement ces éléments : 

Ressources 
Hyperliens / 
documents 
électroniques 

Icônes ou symbole (liens vers des documents 
électroniques ou des sites Internet qui permettent 
d’enrichir la compréhension des concepts/propositions). 

Des outils de 
collaboration 

Annotation Icône ou symbole (de type « Post-It »). 

Discussion Icône ou symbole. 

  



Comprendre et utiliser les cartes conceptuelles 

André Laflamme 5 de 8 
 

Établissement des concepts et des liens de propositions 

Les manipulations du logiciel CmapTools pour réaliser les étapes qui suivent sont rassemblées 
dans un tableau commode que voici : 

Tableau 2 - Opérations courantes de production d'une carte conceptuelle 

 Concept Lien de proposition Ressource 

Ajouter 

Cliquez deux fois 
dans une zone 
libre de l’aire de 
traçage pour 
ajouter un 
nouveau concept. 
Saisissez le titre du 
concept. 

Sélectionnez le concept-
source (simple clic), puis, en 
maintenant le bouton 
gauche de la souris 
enfoncée, glissez depuis le 
jeu de flèches qui coiffe le 
concept vers le concept de 
destination.  S’il n’y a pas de 
concept de destination, 
CmapTools crée un nouveau 
concept. 
Saisissez le titre du lien. 

Préalable : Si votre 
ressource à ajouter est un 
document électronique 
(par exemples : document 
Microsoft Office, document 
Adobe Acrobat, etc), 
téléversez-le 
préalablement dans un 
dossier spécifique à la 
carte en préparation. 
Sélectionnez le concept ou 
le lien (simple clic) puis 
utilisez le bouton de droite 
de la souris pour faire 
apparaître le menu 
contextuel. 
Ajoutez le type de 
ressource désirée. 

Modifier 

Sélectionnez le 
concept (double-
clic) puis modifiez- 
le titre du (utilisez 
les flèches de 
déplacement du 
clavier pour 
circuler dans le 
texte). 

Sélectionnez la zone de texte 
du lien (double-clic) puis 
modifiez le titre (utilisez les 
flèches de déplacement du 
clavier pour circuler dans le 
texte). 

Pour modifier un 
document déposé comme 
ressource, vous devez 
éditer le document source 
avec le logiciel 
d’application d’origine, 
puis copier le nouveau 
fichier résultant dans le 
dossier de ressources de 
votre projet Cmap. 
Pour modifier le lien vers 
une ressource, cliquez 
avec le bouton de droite 
sur l’icône de la ressource 
pour faire apparaître le 
menu contextuel, puis 
sélectionnez la rubrique 
Ajouter & modifier les 
liens aux ressources… 

Supprimer 

Sélectionnez le 
concept (simple 
clic) puis appuyez 
sur la touche 
Supprimer de 
votre clavier. 

Sélectionnez le lien (simple 
clic) puis appuyez sur la 
touche Supprimer de 
votre clavier. 

Sélectionnez la ressource 
(simple clic) puis appuyez 
sur la touche 
Supprimer de votre 
clavier. 

Enregistrer Sauvegardez votre production en enregistrant régulièrement votre document; 
Menu Fichier > Sauvegarder Cmap. 

Créer un concept 

Ajoutez votre premier concept à la carte conceptuelle.  Il est probable que ce premier concept 
soit le point focal de votre carte.  Si c’est le cas, privilégiez le centre haut de l’espace de travail.  
Il serait aussi possible de tracer une carte ayant son point d’entrée principal au centre gauche de 
l’écran. 
Vous pouvez ajouter les concepts suivants en tentant de créer des zones naturelles de 
regroupement.  De cette façon, le placement fin des concepts en sera facilité.  La pratique des 
cartes conceptuelles vous fournira plusieurs stratégies de mise en forme de démarrage. 

Lier un concept pour former une proposition 

Lorsque vous cliquez sur un concept pour le sélectionner, des flèches coiffent le sommet du 
concept.  En cliquant spécifiquement dans cette zone de flèches puis en maintenant le bouton 
gauche de la souris enfoncée, vous pourrez indiquer à CmapTools vers quel concept il doit 
ajouter un lien.  Il est bien important de glisser votre souris jusqu’au centre de la forme 
graphique qui représente votre concept (par défaut : un rectangle).  Si vous glissez vers un 
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endroit où CmapTools ne repère pas d’élément, il déduira que vous voulez ajouter un nouveau 
concept à votre carte. 

 
Figure 3 - 
Concept non 
sélectionné. 

 
Figure 4 - 
Concept 
sélectionné (1 
clic) et prêt à 
être lié à un 
autre concept. 

 

Figure 5 - 
Concept 
sélectionné (2 
clics) et prêt pour 
l’édition de son 
contenu. 

Figure 6 - Saisie d'un mot de liaison lors de 
l'établissement d'une proposition. 

Mise en forme simple 

La mise en forme d’une carte conceptuelle comporte principalement deux aspects : (1) le 
positionnement des concepts et des liens, (2) le balisage de la carte par le  rehaussement de 
certains de ces éléments à l’aide d’attributs liés aux caractères, aux objets, au traçage des liens 
et aux aspects généraux de la présentation matérielle de la carte.  Les commandes de mise en 
forme sont regroupées à l’intérieur d’une fenêtre « Styles» en surimposition (Fenêtre de la 
carte > Format > Styles…). 

 
Figure 7 – Paramètres des styles de mises en forme de police de caractères (Police), d’objets, de ligne et 
d’arrière plan de carte conceptuelle (Cmap). 

Avant d’appliquer une mise ne forme aux différents objets d’une carte conceptuelle, il importe de 
maîtriser les mécanismes de sélection résumés au Tableau 3. 

Tableau 3 - Mécanismes de sélection 

 Concept Lien (texte) Lien (trait) 

Un Simple clic. Simple clic. Simple clic. 

Plusieurs 
CTRL-clic en maintenant 
la touche CTRL 
enfoncée. 

CTRL-clic en maintenant la 
touche CTRL enfoncée. 

CTRL-clic en maintenant 
la touche CTRL enfoncée. 

Tous 
Menu Editer > 
Sélectionner les 
concepts. 

Menu Editer > Sélectionner 
les phrases de connexion. 

Menu Editer > Choisir les 
liens. 

Les opérations de mise en forme simples sont résumées dans le tableau suivant : 

Tableau 4 – Opérations courantes de mise en forme d’une carte conceptuelle 

 Concept Lien (trait) 

Couleur Fenêtre Styles > onglet 
Objet > Couleur. Fenêtre Styles > onglet Ligne > Couleur. 

Forme Fenêtre Styles > onglet 
Objet > Forme. 

Fenêtre Styles > onglet Ligne > Épaisseur et/ou 
Style (tracé du trait) et/ou Flèches (têtes de 
flèche). 

Alignement 

Fenêtre Styles > onglet 
Objet > Aligner.  Au 
besoin, fixer le pas (en 
pixels). 

Fenêtre Styles > onglet Ligne > Forme (forme du 
tracé). 
Au besoin, utilisez la commande Format > Mise 
en page automatique… Important : sauvegardez 
votre travail avant d’utiliser cette commande. 

Attributs de 
texte Fenêtre Styles > onglet Police > [spécifiez les attributs]. 
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Ajouter des ressources 

Au besoin, vous pouvez ajouter des ressources électroniques à votre carte conceptuelle comme 
ceci : 

1. Glissez-déposez votre ressource depuis votre bureau électronique vers le dossier 
Ressources du Gabarit basique et acceptez le message de CmapTools; 

2. Glissez-déposez votre ressource depuis le dossier Ressources vers le concept. 
Pour afficher une ressource, activez cette ressource avec le menu déroulant de l’icône de 
ressource sur le concept. 
Un menu contextuel (clic droit de la souris) vous offre aussi d’autres options. 

Remettre des projets de cartes conceptuelles à son enseignant 

Il existe principalement trois façons de remettre une carte conceptuelle à votre enseignant : (1) 
l’imprimer sur papier, (2) la convertir en document PDF puis la déposer dans votre site de cours 
et, finalement, (3) déposer votre dossier de carte conceptuelle sur le serveur CmapServer 
publique de l’IHMC.  L’enseignant vous précisera la méthode qu’il souhaite employer. 

Méthode 1 : impression sur papier 

Pour imprimer une carte conceptuelle sur 
papier, utilisez d’abord la commande 
Fichier > Aperçu avant 
impression… pour établir l’orientation de 
l’impression portrait (verticale) ou paysage 
(horizontale), ainsi que le nombre de feuilles 
sur lesquelles cette impression s’étendra.  
Dans l’exemple ci-contre, l’impression est 
prévue sur deux pages selon l’orientation 
paysage.  Cliquez ensuite sur Imprimer.  
Au besoin, assemblez les pages. 

 
Figure 8 – Paramètres et prévisualisation 
d’impression. 

Méthode 2 : Conversion PDF et dépôt sur le site du cours 

Pour convertir une carte conceptuelle en format PDF, utilisez la commande Fichier > 
Exporter la Cmap sous… > Format PDF… > Options > Size : Letter ou 
Legal, Orientation : Portrait ou Landscape (paysage) > OK > 
nommez votre carte, sélectionnez le dossier de destination > 
Enregistrer. Il ne reste qu’à déposer le document PDF résultant dans votre site de cours .. 

Méthode 3 : Dépôt sur le serveur CmapServer publique de l’IHMC 

Votre cours utilise un serveur CmapServer publique de l’IHMC.  Pour copier votre projet de carte 
conceptuelle dans le dossier du cours, dans CmapTools faites : 
Cmaps partagées dans Places > IHMC Public Cmaps (3) > Users > 
ETS-MGP810 Séminaire sur la gestion des projets de construction > 
Dépôt 

Code d’accès : mgp810 (respectez la casse) 
Mot de passe : ets-a2009 (respectez la casse) 

Partager des cartes conceptuelles sans accès à un serveur CmapServer 

Dans ce cas type, le concepteur de cartes conceptuelles produit ses cartes avec le logiciel 
CmapTools puis les partages avec des collaborateurs qui possèdent le logiciel CmapTools et qui 
pourront éventuellement modifier ces cartes. 
Sachez que vos projets de cartes conceptuelles situés dans la section Cmaps dans Mon 
ordinateur sont entreposés dans le dossier « My Cmaps » du dossier Mes documents (avec 
Windows) et dans le dossier Documents (avec MacOSX).  Le répertoire My Cmaps est créé 
automatiquement à l’installation du logiciel CmapTools. 
Pour transmettre un projet complet de cartes conceptuelles (cartes et ressources) depuis votre 
ordinateur à celui d’un collaborateur : 

1. Copiez d’abord votre dossier de projet, depuis l’ordinateur source (exemple Windows : 
Mes documents> My Cmaps > [dossier de projet]), sur un média 
externe (exemples : disquette, cédérom, bâtonnet de mémoire, etc.); 
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2. Copiez ensuite le contenu du média externe vers le répertoire My Cmaps de l’ordinateur 
de destination (il est aussi possible d’envoyer le dossier source vers un dossier 
compressé (format ZIP) à transmettre à vos collègues par courriel ou par publication sur 
un site Web ou un site de cours en ligne WebCT). 

3. Lancez le logiciel CmapTools; votre dossier de projet devrait apparaître dans la liste des 
projets Cmaps dans Mon ordinateur de l’ordinateur de destination. 

 
Important : 
Si votre version installée de CmapTools est de 
version 5 ou plus, alors il est possible de cliquer 
deux fois sur un document de carte conceptuelle ce 
qui lancera le logiciel CmapTools pour afficher cette 
carte. 
Si votre version installée de CmapTools est de 
version 4 ou moins, alors : Les cartes conceptuelles 
créées par le logiciel CmapTools et stockées dans le 
dossier My Cmaps de votre dossier Mes documents 
semblent ne pas être reconnues par le système 
d’exploitation Microsoft Windows car celui-ci affiche 
une icône générique pour représenter ces documents.  
Pourtant, il n’en est rien!  Vos documents CmapTools 
s’ouvriront correctement si le logiciel CmapTools est 
installé sur le micro-ordinateur concerné.  N’oubliez 
pas que pour ouvrir une carte conceptuelle en 
format CmapTools, vous devez d’abord lancer 
le logiciel CmapTools puis ouvrir la carte avec 
la commande habituelle d’ouverture de 
document (Menu Fichier > Ouvrir). 

 
 

 
Figure 9 - Icône de document 
CmapTools dans l’environnement 
Microsoft Windows (CmapTools 
version 5 ou plus récente 
seulement). 

 

 
Figure 10 - Icône générique des 
documents CmapTools dans 
l'environnement Microsoft Windows 
(CmapTools version 4 ou moins 
récente). 

 


